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DE SEKS DESIGNTIPS
1. AFGIV KORREKT BESTILLING

Husk at oplyse alle bestillingsdetaljer, når du afgiver ordre.

Typiske bestillingsdetaljer:
	Ì Produkt (hvilken tryksag du ønsker)
	Ì Oplag (hvor mange du skal bruge)
	Ì Dit telefonnummer – gerne mobil
	Ì Forsendelsesadresse
	Ì Faktureringsadresse

Bestil online og undgå problemer. 
Når du bestiller via hjemmesiden, er du nemlig sikret at få afgivet de relevante informationer.

2.  ANVEND KORREKTE FARVER

Med undtagelse af enkelte tryksager med Pantone-farver, trykkes dine tryksager med fire CMYK-farver. 

Husk trykfil i CMYK-farver
I de fleste grafiske programmer kan du vælge at arbejde i CMYK-farver  
(fremfor RGB-farver).

Sådan defineres farven sort
Skal du definere farven sort (til dækflade) med CMYK-farver, får du det bedste 
resultat ved at vælge: C=60 M=40 Y=40 K=100. Sort tekst og streg-tegninger skal 
dog defineres som C=0 M=0 Y=0 K=100.

Pantone-farver
Som nævnt trykkes enkelte tryksager med Pantone, som er special-farver, der ikke kan skabes med 
CMYK-skalaen. Det er vigtigt, at Pantone-farven er oprettet som special-farve i fx InDesign.



3. BENYT KORREKT FILTYPE

Du opnår de bedste resultater, når du benytter PDF-format med alle fonte inkluderet i filen.

ANDRE POPULÆRE FILTYPER

Tif/jpg
Næsten alle grafiske programmer giver mulighed for at gemme i billedformaterne tif og jpg.
Gem filen i maksimumkvalitet, i CMYK-farver og min. 300 ppi.
Er der tekst på tryksagen, anbefaler vi min. 600 ppi for optimal skarphed.

Eps
Et populært vektorformat, der typisk giver bedre resultat end tif/jpg. Husk at konvertere alle fonte til kurver 
(vektoriseret/outlined). Fonte kan også være inkluderet i filen.

InDesign, Photoshop og Quark
Eksportér til PDF-format. Alternativt eksportér til eps, åbn eps-filen i Illustrator, konvertér alle fonte til outlines, 
og gem som eps/PDF.

Microsoft Office (Word, Excel, PowerPoint, Publisher)
Udskriv til PDF-format (kræver Adobe Acrobat eller en gratis PDF-writer).

Husk, at Microsoft Office-formaterne ikke er beregnet til grafisk brug, og vi påtager os ikke ansvaret for farverne i den 
endelige tryksag.

Gratis PDF-generator:
Har du problemer med at generere PDF-filer, kan du downloade en gratis PDF-writer på fx www.cutePDF.com.

4. KORREKT OPLØSNING (PPI)

Ved at bruge korrekt dpi undgår du, at din tryksag bliver kornet og uskarp. Som udgangspunkt skal trykfiler 
ligge i 300 ppi. Vi anbefaler i øvrigt ikke, at tekst laves som bitmap.

DPI eller PPI?
Selvom udtrykkene DPI (dots per inch) og PPI (pixels per inch) begge beskriver 
opløsningen (eller klarheden) af et billede, er de ikke det samme.

PPI beskriver antallet af pixels, der vises per tomme på en skærm. 
DPI bruges til tryk og beskriver antallet af fysiske blæk-prikker på en tryksag.

	Ì Billeder og læseafstand, fx en folder (10-50 cm): min. 150 ppi-300 ppi for optimalt resultat.
	Ì Billeder på stå-afstand, fx plakater, roll-ups og lign. (over 50 cm): min. 60 ppi – helst 100 ppi. 
	Ì Billeder på bannere, der læses på flere meters afstand: 5-50 ppi afhængigt af om læseafstanden  

er 5 eller 20 m.

5 ppi lyder helt tosset, men faktisk betyder det, at hver pixel er 0,5 x 0,5 cm – og sådan en lille prik kan man 
altså ikke se på 20 meters afstand – hvorfor 5 ppi kan være helt fint.

EPS

EPS

EPS

http://www.cutepdf.com/products/cutepdf/Writer.asp


5. HUSK PLADS TIL BESKÆRING

Det vigtigste råd, da her sker mange fejl.

Ekstra 3 mm i layoutet
Vigtigst er det, at du husker at tillægge 3 mm på alle 
sider af tryksagen, også kaldet ”bleed”. 

Tekst og grafikelementer bør have en sikkerhedsaf-
stand på mindst 3 mm fra tryksagens endelige kant.

Se flere beskæringstips under dokumentopsætning.

6. OVERPRINT OG OUTPUT

Undgå at blive overrasket over, at noget forsvinder!

InDesign, Illustrator og Acrobat kan indstilles til altid at vise overprint 
– derved vil du opdage eventuelle problemer med layoutets farvelag.

Overprint i InDesign og Illustrator:
Slå Overprint Preview til i InDesign – så vil alt layout simulere det færdige tryk:  
InDesign > View > Overprint Preview.

Overprint i Acrobat Pro:
Opdag fejl ved gennemgang af den trykklare PDF. Det anbefales altid at have slået overprint-visning til:  
Edit > Preferences > Page Display > Page Content and Information > Use Overprint Preview > Always. 

Output Preview værktøj i Acrobat:
Du kan også anvende Output Preview som værktøj. Slå Simulate Overprint til i Acrobat:  
View > Tools > Print Production > Output Preview > Simulate overprinting.

Overprint Ikke overprint



SKABELONER
De fleste trykkerier tilbyder skabeloner til at designe sine tryksager. 
Skabeloner indholder typisk vejledning i forhold til beskæring, sikkerhedszoner, dokumentstørrelse mv. 

Kontakt din rådgiver, hvis du ønsker en skabelon på en standard-tryksag.

DOKUMENTOPSÆTNING
Sådan gør du, hvis du ikke vil bruge skabeloner.

1. Start et nyt dokument 
Kan også hedde ”ny side”, ”nyt canvas” eller ”nyt artboard”. 

2. Dokumentopsætning – InDesign 
Sæt dokumentstørrelsen til tryksagens færdige mål; fx visitkort (85 x 54 mm). 

3. Indsæt 3 mm beskæringszone og 3 mm sikkerhedszone  
Dette gøres i menuen ”Nyt dokument/New document” under  
”Beskæring og satslinje”. 

4. Dokumentopsætning – andre programmer 
Sæt dokumentstørrelsen 3 mm større end tryksagens endelige størrelse på alle fire sider.  
Dette kaldes at ”tillægge beskæring”.

Eksempel på tillæg af 3 mm beskæring:
Tryksag Færdigt mål Dokumentstørrelse
Visitkort 85 x 54 mm 91 x 60 mm

A6-postkort 105 x 148 mm 111 x 154 mm

A5-flyer 148 x 210 mm 154 x 216 mm



DE TRE BESKÆRINGSTIPS

Hvis nedenstående tre bekæringstips følges, vil der sjældent opstå fejl. 

TIP 1
Layout filen i korrekt størrelse fra starten!

Endeligt format: 
Layout-format 

(arbejdsområde):
A0-format (841 x 1189 mm) 847 x 1195 mm

A1-format (594 x 841 mm) 600 x 847 mm

A2-format (420 x 594 mm) 426 x 600 mm

A3-format (297 x 420 mm) 303 x 426 mm

A4-format (210 x 297 mm) 216 x 303 mm

A5-format (148 x 210 mm) 154 x 216 mm

A6-format (105 x 148 mm) 111 x 154 mm

A7-format (74 x 105 mm) 80 x 111 mm

Visitkort (54 x 85 mm) 60 x 91 mm

TIP 2
Grafik, der skal gå til kanten, skal fylde hele arbejdsområdet!

TIP 3
Placér ikke tekst for tæt på kanten!

Forkert placering af tekst – korrekt baggrund Korrekt placering af både tekst og bagrund

Forkert placering af baggrundsgrafik Korrekt placering af baggrundsgrafik

DIT  LOGO

DIT  LOGO

DIT  LOGO

DIT  LOGO
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HVORFOR RAMMER OG TEKST IKKE ANBEFALES

Se, hvordan en ”skæv” beskæring på blot 1 mm påvirker et layout, der ”i teorien” er fint. 
Hvis vi kunne skære mere præcist end +/- 1 mm, var 3 mm til beskæring ikke nødvendigt – men det er det.

Teori: Rammen skal være 2 mm bred 
hele vejen rundt. 

Praksis: Rammen kommer til at være 
1 og 3 mm bred.

Teori: Rammen skal sidde 3 mm fra kanten 
hele vejen rundt.

Praksis: Rammen kommer til at sidde 
2 og 4 mm fra kant. 

Teori: Den højre- og venstre-stillede tekst 
skal være placeret 3 mm fra kant.

Praksis: Teksten kommer til at sidde 
2 og 4 mm fra kant. 

Firmanavn
Adresse 99
8200 Postnummer

Tlf.: 88 88 88 88
Mobil: 88 55 88 55

navn@firmanavn.dk

Kjell Kalmar
Chef

Firmanavn
Adresse 99
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Kjell Kalmar
Chef



PREMIUM TRYKFILER
Denne type tryksag stiller nogle krav til dine trykfiler.

Vælg mellem:
	Ì Guldfolie
	Ì Sølvfolie
	Ì 3D-lak

Hver effekt, der anvendes, skal defineres i trykfilen som en unik spotfarve 
(staffagefarve). Hvilke farver der anvendes til de forskellige effekter, 
er underordnet, men optimal kontrast til selve trykfilen er en fordel.

Partiel lak navngives ”VARNISH”, sølvfolie ”SILVER” og guldfolie ”GOLD”  
– altid med store bogstaver. 

OVERPRINT

Overprint skal ALTID anvendes på de partielle elementer – uanset om der ligger trykfarve 
under effekten.

OVERLAP 

Effekter, der overlapper, skal slå hul, så der ikke lægges flere lag oven på hinanden. Det skyldes, at der 
anvendes lak, som klæber på folien, og lag med overlap vil derfor blive for tykke. 
Fig. A1 til venstre viser de tre varianter i den færdige fil. Fig. A2 viser elementerne trukket fra hinanden.

SMÅ ELEMENTER

Vær opmærksom på, at partiel lak og folie fungerer bedst, hvis elementerne ligger min. 3 mm fra hinanden, 
fra kant og/eller fals (fold). Vi anbefaler ikke punktstørrelser under 12 pkt.

Fig. A1 Fig. A2

VARNISH (lak) SILVER (sølv) GOLD (guld)



MISPAS

Da hver effekt lægges på trykarket i en særskilt arbejdsgang, kan mispas forekomme på elementer med lille 
tolerance (Fig. B1). Sørg altid for at tage højde for dette i designet. Fig. B2 viser et mispas på kun 0,3 mm.

NEGATIV EFFEKT

Ønskes negativ effekt i folie, skal elementer – eksempelvis tekst som vist til højre (Fig. C1) – være med en vis 
tolerance. Folien overlapper den bagvedliggende grafik, samtidig med at der er taget højde for mispas. 
Fig. C1 er lavet med en hvid kasse som baggrund (Fig. C2). 
Samme opgave kan også løses med en stroke (Fig. C3).

Fig. B1 Fig. B2

VARNISH (lak) SILVER (sølv) GOLD (guld)

Ficipiet fuga. Mint 
occusa que plignis et 
ad eatem rerum aut 
et andis est, quam 
ratem quam lia niet 
labor alMo tem inc-
tem. Dam alibusdae

Ficipiet fuga. Mint Ficipiet fuga. Mint 
occusa que plignis et occusa que plignis et 
ad eatem rerum aut ad eatem rerum aut 
et andis est, quam et andis est, quam 
ratem quam lia niet ratem quam lia niet 
labor alMo tem inc-labor alMo tem inc-
tem. Dam alibusdaetem. Dam alibusdae

Fig. C1 Fig. C2 Fig. C3



FARVEPROFILER
Ì Til bestrøget (coated) papir, som fx Silk, anbefales FOGRA39.
Ì Til ubestrøget (uncoated) papir, som fx offset, anbefales FOGRA47.

EKSPORT AF FILER
Vi anbefaler, at du installerer trykkeriets eksportindstillinger, hvis du designer din tryksag  
ved hjælp af Adobes programmer (InDesign, Illustrator og Photoshop).

SÅDAN VIRKER DET

1. Download zip-fil, og pak den ud
2. Dobbelt-klik på filen
3. Eksport-indstillingen er nu installeret og findes i din InDesign-menu.

Kontakt din rådgiver for at få tilsendt eksportindstillinger.

FORDELEN VED EKSPORTINDSTILLINGER

Når du bruger trykkeriets eksportindstillinger, bør der være styr på:

• Problemer med transparens
• Problemer med beskæring
• Problemer med manglende fonte
• Problemer med unødvendigt høj opløsning

Spørg altid trykkeriet til råds for deres eksportindstillinger.

KORREKT EKSPORT – ENKELTSIDET ELLER OPSLAG

Når du eksporterer din trykfil fra InDesign, kan du vælge at eksportere siderne  
som enkeltsider eller opslag. 

	Ì Størstedelen af tryksager skal eksporteres som enkeltsider i ét dokument (pdf) 
      og i korrekt rækkefølge. 
	Ì Omslag og foldere skal eksporteres som opslag i ét dokument (pdf),  

      og siderne skal være sammensat korrekt.  
      Husk at indsætte en ryg, hvis der er tale om en limbundet bog.

Unavngivet 1   2-3Unavngivet 1   2-3 29-11-2021   11:19:0329-11-2021   11:19:03

Unavngivet 1   1Unavngivet 1   1 29-11-2021   11:18:1129-11-2021   11:18:11

Opslag

Enkeltsidet



TJEKLISTE INDEN UPLOAD
 5 Korrekt beskæring

Jeg har lavet korrekt beskæring, og min trykfil er derfor 3 mm større på alle kanter end den endelige tryksag.

 5 Korrekt sikkerhedszone
Jeg har placeret tekst, grafik og logoer inden for sikkerhedszonen (min. 3 mm fra tryksagens kant).

 5 Korrekt opløsning
Alle billeder i min trykfil har en opløsning på min. 300 dpi, når de er placeret i 100 % i dokumentet. 
Psssst... Er du i tvivl, om fx opløsningen er god nok, så forstør dit skærmbillede til 200-300 %.  
Hvis det stadig ser skarpt og ikke-pixeleret ud, så vil det også blive pænt i tryk.

 5 Korrekte farver
Min trykfil er lavet med CMYK-farver. Har jeg indsat billeder eller andet i RGB-/Pantone-farver, lader jeg  
trykkeriet konvertere til CMYK-farver for at få det bedste resultat. 
Jeg er bekendt med, at farverne kan ændre sig ved konverteringen.

 5 Korrekt PDF med fonte inkluderet
Alle fonte blev embedded/inkluderet, da jeg eksporterede min PDF-fil. 

 5 Ingen opslag (ved tryksager med flere sider)
Min PDF-fil indeholder siderne fortløbende. Et 24-siders hæfte kræver således en PDF-fil med 24 sider. 
Fremsend derfor ikke PDF-filer med siderne placeret over for hinanden (som opslag). 

GRATIS FILTJEK
Langt de fleste trykkerier tilbyder gratis og uforpligtende tjek af dine trykfiler.

Typisk tjekkes der for:
	Ì Korrekt beskæring
	Ì Korrekt opløsning (dpi)
	Ì Format/filtype
	Ì Korrekte farver 

Spørg din rådgiver om hvilke fejl/mangler,  
der tjekkes for.
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